
Chapter 11  Managing Devices 

Overview

This chapter describes how to:

• Add and remove configured devices
• Test devices
• Troubleshoot soft errors
• Prioritize devices for specific operations
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Introduction

The device tree displays the connected devices that were turned on at installation or when
you most recently scanned the SCSI bus. To display any devices that may have been turned



on since you accessed Device Manager,  open the Operations menu and select  Scan for
Devices. Any devices that were recently turned on appear in the window. 

The device tree includes all devices on the SCSI bus of your Backup Director installation
server,  whether or  not you have added them as configured devices.  Configured devices
appear with logical names beside the device drive icons. 

Non-configured devices appear with the label “Not Configured.”  SCSI hard drives appear on
the device  tree,  and the  tree  indicates  their  type,  such  as  a  CD-ROM or  Direct  Access
Storage Device. However, SCSI hard drives are not available for Backup Director operations. 

TIP: You may want to collapse the adapter icon of any SCSI hard drive on
the device tree.  Collapsing the adapter  icon will  hide the non-configurable
device and may help to avoid confusion later. Use the Tree/Collapse option.

Backup Director allows you to use different types of devices (optical and tape drives, for
example) for your backup operations. These devices can be daisy-chained or attached to
separate SCSI host adapters. Once you have installed the devices, you can then configure
them for different operations, if necessary.

See the Installation Guide for more information about installing devices.

Device Manager Tool Bar

The Device Manager tool bar provides a short cut to commonly used operations:

Add Device¾Add an unconfigured device

Remove Device¾Remove a configured device

Scan for Devices¾Search for any new devices on the bus.

Help¾Open the Help menu.

Adding a Device

When you  first  install  Backup  Director,  the  program scans  the  SCSI  bus  to  identify  all
connected devices. You can configure one or more devices during installation. At installation,
you can only configure the drive of an autoloader. You must first install AutoLoader Software
before configuring the  autoloader  (specifically,  the  robotic  arm also known as  a “media
changer”).  The  remaining  backup  devices  appear  as  “Not  Configured”  in  the  devices
window. 

To add a device 

1. Be sure that the device you want to configure is turned on. 

> If the device was turned off, you must turn it on and scan the SCSI bus
again. Open the Operations menu in Device Manager and choose the Scan for
Devices option. 

2. Highlight the device icon, open the Operations menu, and select  Add Device. The
“Not Configured” status disappears from the tree.



> To add an autoloader, highlight the device icon, open the Operations
menu and select  Add Device.  If  there are multiple devices,  add these first
before  adding  the  autoloader.  Highlight  the  autoloader  icon.  Select  Add
Device. Notice that the device icon appears connected to the autoloader icon
and no longer appears as an independent item on the tree.

Once you have added the device, its logical name is stored in the System Control Database.
For more information about using an autoloader to perform operations, see the AutoLoader
Software Guide.

TIP: If you have multiple backup devices, see chapter 5 for information on
enabling concurrency. See chapter 2 for a description of concurrent backup
operations and concurrent jobs.

Assigning a Logical Name to a Device

Backup  Director  automatically  assigns  configured  devices  a  logical  name  such  as
“DEFAULT_0_1”. The first number refers to its adapter number and the second number refers
to the device's SCSI ID. You may want to give a device a more descriptive logical name.

To change the logical name of a device

1. From the device window, highlight a device.

2. Open the Operations menu and select the Edit Device option. The Configure Device
dialog box appears.

3. In the Logical Name parameter, type the name you want to call the device.

4. Choose OK to save the name.

Changing the SCSI Address

If you are moving a device to another SCSI card or the dip switch is accidentally turned off,
Device Manager can no longer identify the device (it appears dimmed on the device tree).
You can add the device again to the configuration list. 

A better solution is to change the SCSI address so that you do not lose the device statistics
that have accumulated for the device.

To change a device's SCSI address

1. Open the Operations menu and select Scan for Devices.

2. Highlight the device. 

3. Open the Operations menu and select Edit Device. The Configure Device dialog box
appears. 

4. Enter the new host adapter, SCSI ID, and logical unit number information and choose
OK.

Upgrading Devices



Upgrading your backup device can enhance the flexibility and performance of your Backup
Director installation. If your new device uses a different media type, you can continue using
the current  media library.  Backup Director  simply  adds the new media to the  managed
media sets.

NOTE: If you are upgrading firmware, you must unload PALMEDIA.NLM from
the server before adding the new firmware. If you do not, the SCSI bus “locks
up.” At the server console prompt, type UNLOAD PALMEDIA. After you have
upgraded  the  firmware,  return  to  the  server  console  and  type  LOAD
PALMEDIA. NetWare adds the PALMEDIA module.

To upgrade a device

1. Open the File menu and select  Scan for  Devices.  The new device appears in the
device tree.

2. Highlight the new device.

3. Open the File menu and select Add Device. 

4. Edit the parameters for the new device if appropriate. For example, if you are adding
an autoloader, edit the new device's slot configuration.

Upgrading to a Different Media Type

If the new device also entails a media type change (e.g., upgrading from 4mm to 8mm), you
may want to configure the original device for restore operations only.  Set the operational
priorities  using  the  Operations/Edit  Device option.  At  the  next  rotation the  program will
continue to request the original media.

To use only the new media type for write operations,  retire the original  media from the
managed  media  sets.  The  program  will  automatically  request  these  media  for  restore
operations if necessary.

Removing a Device

To remove a device from the configured device list

> If you are removing a single tape drive, highlight the device icon, open
the Operations menu, and select Remove Device.

> If you are removing an autoloader and its device from the configured
device  list,  highlight  the  autoloader  icon,  open  the  Operations  menu  and
select Remove Device. Highlight the device icon and select Remove Device. If
there are multiple drives in the autoloader, repeat this task for each device.

Once you have removed the device, its logical name is removed from the System Control
Database. The device now appears in the device window as “Not Configured.”

NOTE: If  a device on your device window appears dimmed, the device has
been disabled.  It  may have been turned off or unplugged since you most
recently scanned the SCSI Bus. Check the status of the device and scan the
bus for devices.

Device Summary Report



Backup  Director  can  print  a  list  of  devices  currently  configured  for  Backup  Director
operations. See chapter 7 for information about viewing and printing the Device Summary
report.

Editing the Autoloader's Slot Configuration

There are two reasons for editing the slot configuration:

• You are reserving some of the slots, possibly for use by another drive.
• You are changing the location of  the cleaning cartridge.  By default,
Backup Director uses the total number of slots designed for the device and
does not assign a location to the cleaning cartridge.

To edit the slot configuration

1. Highlight the device icon of the autoloader you want to reconfigure.

2. Open the  Operation menu and select  Edit Device. The Configure Autoloader dialog
box appears.

3. Enter the appropriate slots.

> To specify the range of slots you want Backup Director to use, indicate
the beginning and end of the range in the First and Last parameters.

> To specify the cleaning cartridge's location, enter the slot number in
the Cleaning Required parameter.

4. Choose OK to save your changes.

Loading Media into Autoloaders

If  you are using an autoloader with an import/export door, you may need to perform an
additional step when loading different media into the device.

To load media into the autoloader's door

1. Open the Operations menu and select  Import Load the media into the autoloader.
When you close the door, the device loads the media into the first available slot. 

2. Open the Operations menu and select Scan for Devices. To confirm that the correct
media  is  now mounted,  highlight  the  device  and  select  the  Status  tab.  The  tab
displays the label of the media currently mounted in the device.

Testing Your Device

If you receive system messages indicating a media or hardware problem such as a failed
write operation or excessive soft errors, you should perform a read/write test on your device.
A read/write test identifies read, write, compare, and positioning failures. The short version
takes  approximately  15  to  20  minutes;  the  long  version  takes  approximately  45  to  60
minutes. In most cases, the short test is sufficient. If you continue to have problems, run the
long test. 



TIP: Dirty backup devices are responsible for most soft errors. Avoid soft
errors  by  periodically  reviewing  the  Statistics  tab  in  Device  Manager.  The
Cleaning Required check box on the Devices tab indicates that the device
needs to be cleaned immediately.

WARNING: To avoid losing data, never perform the read/write test
with a tape that contains data. 

Read/Write Test

To test the read/write tape heads

1. Insert blank media into the drive.

2. Highlight the device icon.

3. Open the  Operations  menu and  choose  Test  Device.  The  Test  Device  dialog  box
appears.

4. Indicate which test (Long or Short) you want to perform.

5. Indicate whether you want to record the SCSI instructions that occur during the test.
Selecting  the  Device  Trace option  creates  an  attached  file  that  can  be  viewed
through the System Message window. When this option is turned off, the program
simply  reports  the  percentage  of  read  and  write  errors  that  occurred  as  system
messages.

6. Specify any other parameters for this job.

7. Choose OK to submit the test job to the job queue. The results of the test are written
as an attachment in the System Messages window. If the test indicates a relatively
high percentage of soft errors, see the soft errors section below for troubleshooting
recommendations.

Autoloader Test

In addition to being able to read and write data correctly, autoloaders must also retrieve
media from the correct slot and load media into the device. The autoloader test determines
whether the robotic arm performs correctly by checking the robotic arm's ability to locate,
retrieve, and load media.

To test the autoloader

1. Highlight the autoloader icon.

2. Open the Operations menu and choose Test Device. 

3. Indicate whether you want to perform the short or long autoloader test. The length of
the test depends on the type of autoloader you have and the number of media the
autoloader must retrieve and load. The short test loads each media once and the
long test loads each media five times. The longer test is more likely to identify errors
that occur sporadically.

4. Indicate  whether  you want  to  record  the  SCSI  instructions  that  occur  during  the



read/write test. 

5. Specify any other parameters for this job.

6. Choose OK to submit the test job to the job queue.

Reviewing Test Results

The results of a SCSI device trace or a hardware test are written to files attached to the
System Messages database. 

To view test results

1. From the Control Panel in Control Console, select the Status tab and choose System
Messages. The System Messages window appears.

2. Highlight the system message that corresponds to the module (PALUTIL.NLM) and the
job ID of the test.  The full  description of the system message appears below the
system messages. 

3. Choose the Details button. The System Messages dialog box appears. 

4. Choose the  Attached button. An window displaying the attached file appears. This
displays the contents of a separate file such as a SCSI device trace report.

> To print the attached file, open the Operations menu and select the
Print option.  The Print  dialog box appears.  Select  printing parameters and
choose OK.

5. Choose OK to close the attached file window.

Cleaning Your Tape Drive

If  you  have  an  autoloader  and  AutoLoader  Software  loaded,  the  program automatically
detects when the device needs to be cleaned.  The AutoLoader Software loads the available
cleaning cartridge and cleans the drive for you. The AutoLoader Software does not provide
automatic cleaning for optical drives. If you have an optical drive or a standalone tape drive
device, Backup Director can help you keep track of the cleanings you perform.

To record that the device has been cleaned

1. Clean  the  device  according  to  the  manufacturer's  instructions.  See  Appendix  B,
“Maintaining  Your  Tape  Drive,”  for  recommendations  and  cleaning  schedules  for
various devices.

2. Highlight the device icon representing the device you cleaned.

3. From the device's Statistics tab, choose the  Record a Cleaning button. The new
date appears in the Time of Last Cleaning parameter and the Bytes Read since
Last Cleaning is set to zero. 

Media and Device Errors



This section helps you identify types of media errors that can occur.

There are four basic types of media messages:

• Tape positioning
• Soft errors 
• Unrecoverable write error 
• Unrecoverable read error 

When any of these types of media errors are reported, follow the troubleshooting procedures
outlined below.

NOTE:The first read operation on a blank tape (rotation day) may result in a
higher than normal soft error count. This is due to the debris that remains
from the manufacturing process.  Ignore the  initial  errors since subsequent
reads should result in a significantly lower value.

Soft Errors Reported by Tape Drive 

A soft error is an error that was corrected through some form of recovery action. If the tape
heads encounter debris or a defect, they attempt to write the data on another location on
the media. Soft errors are a normal part of writing and reading magnetic tape and are a
drive's way of compensating for defects in the tape and debris that momentarily clog a
read/write head. 

Backup Director monitors the number of soft errors reported by tape drives. The program
writes a “note” in the System Messages window to notify the users that an unusually high
percentage of errors has occurred.

Occasional soft errors are common and do not necessarily indicate a problem. In fact, many
drives will report a soft error on new or infrequently used tapes that may have collected dust
or become untensioned while idle. However, a consistently high percentage of soft errors
may indicate a problem with the tape or tape drive.

When  the  amount  of  data  read  or  written  is  small,  Backup  Director   allows  a  higher
percentage of soft errors. This helps prevent false alarms, since a small number of soft errors
would have a large effect on the percentage reported.

The note placed in the System Messages window has the following format:

Excessive soft errors reported, percentage = % writing session xx on yy

“xx” is the session, such as “CP57”.

“yy” shows the label of the tape, such as “ADMIN:F:1”.

The  table  below  describes  the  read/write  error  thresholds  used  by  Backup  Director  for
different devices.

Read/Write Errors Threshold

Tape Drive 
Read
Write



DC 600 2.00% 2.00%

4mm DDS DAT 0.55% 5.00%

DLT 3.00% 3.00%

8mm 2.2GB 3.00% 4.00%

8mm 5.0GB 6.00% 8.00%

Troubleshooting Media and Device Errors

Tape  positioning,  soft  error,  unrecoverable  write  error,  and/or  unrecoverable  read  error
messages are typical errors caused by either media or the device. To determine the source
of the problem, you must perform a series of up to three tests in order to identify the source
of the errors. To verify your results, run the tests a second time using a second blank tape.
Occasionally a new blank media (or even an entire box) will be defective and provide false
results.

NOTE: If you are unable to perform operations with a device, you may want to
verify that Backup Director supports your firmware as well as the device. For
the latest version of the Certified Device List, download CDL40.ASC from the
Palindrome BBS.

Tests 1 and 2 use the  Verify operation in Media Manager. When troubleshooting, use this
operation to eliminate the possibility of any media errors, not to diagnose hardware errors.
Refer to the Read/Write Error Thresholds table on the earlier in this chapter.

To check whether the drive needs cleaning (Test 1) 

1. Insert the suspect data tape into the drive.

2. From Media Manager, run the Verify operation.

3. Review any system messages for soft errors. 

> If  the  soft  errors  are  below the  acceptable  threshold level  and  no
fatal error appears, clean the drive with an approved, data-grade cleaning
tape. 

The cleaning process eliminates any debris which may
cause intermittent errors. Before resuming normal operations,
you  may  want  to  run  another  Verify operation  as  an  added
precaution. 

> If the soft errors are  above the acceptable threshold level or a  fatal
error appears, go to Test 2.

To determine whether to retire or forget media (Test 2)

1. Insert a new, blank tape into the drive.

2. From Resource Manager, create a custom backup job on approximately 10 to 50 MB
of data and write this session to non-managed media. You do not need to track this
session in the File History Database.



3. From Media Manager, select the session on non-managed media and run the  Verify
operation.

4. Review any system messages for any soft errors.

> If  the  soft  errors  are  below the  acceptable  threshold level  and  no
fatal error appears, go to Step 5 in this test.

> If the soft errors are  above the acceptable threshold level or a  fatal
error appears, go to Test 3 to run a comprehensive test of the tape drive.

5. Clean the drive with an approved, data grade cleaning tape to remove any debris.

6. Insert the suspect data tape into the drive.

7. Run the Verify operation.

8. Check the System Messages window for any soft errors.

> If  the  soft  errors  are  below the  acceptable  threshold level  and  no
fatal  error appears,  clean  the  drive  to  ensure  that  the  drive  functions
properly.

> If the soft errors are  above the acceptable threshold level or a  fatal
error appears  again,  you  must  either  forget  or  retire  this  tape  (see  the
“Forgetting Media” and “Retiring Media” sections in Chapter 10, “Managing
Media.”).

To determine whether the drive is not working (Test 3)

1. Remove the data tape and insert a new, blank tape into the drive.

2. From Device Manager, highlight the device you are investigating and run the short
read/write  test  (Operations/Test  Device).  This  program runs  for  approximately  25
minutes.

3. Check the System Messages window.

> If  the  read/write  test  indicates  drive errors,  such as  read or  write
errors, contact the vendor for information about returning the drive for repair.

> If the read/write test indicates  normal drive operation, investigate
possible contamination of data tapes or changes in your system's operating
environment. 

Setting Device Priorities 

This section is for users with more than one backup device and who want to reserve devices
for a specific purpose. 

Numbered device priorities are not absolute. During a backup operation, the program will
use a device with a lower priority if it has eligible media. As long as the device is available
for the operation, the program uses that device if it had the preferred or required media is



loaded on a device 

NOTE: If  backup  sessions  are  written  to  WORM  (Write  Once  Read
Many)devices, they will become permanent sessions, since you cannot erase
data from WORM devices.

For  restore  operations,  if  two or  more  eligible  media  are  loaded on  configured devices,
Backup Director uses the device with the highest priority.

Example 

Let's assume you are replacing an older tape drive with a faster drive using different media.
You want to gradually eliminate the need for the original drive.

Device
Backup
Restore

Old Tape Drive N/A 2
New Tape Drive 1 1

Retire the media used by the original drive. You can then configure your original drive to
perform restore operations only. At the next automatic job, the program prompts you for
blank media with which to add to the existing media set. 

Your new tape drive will be used for all backup and restore operations from the new media.
You can use the original tape drive to restore from the original media type without having to
create a temporary installation for the old device. 

To edit operational priorities

1. Highlight the device icon whose priorities you want to change.

2. Open the Operations menu and select the  Edit Device menu option. The Configure
Device dialog box appears.

3. In each parameter,  Backup and  Restore, set the value to a specific priority. The
value 1 is the highest priority; 99 is the lowest. 

> To  de-activate  a  device  for  an  operation,  you  can  select  N/A.  The
device is no longer available for the selected operation.

4. Choose OK to save your changes.

___________________________


